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1 INTRODUCTION  

1.1 THE MOTOR VEHICLE EMISSIONS INVENTORY 
 
An emissions inventory is a critical element in the control of air pollution 
and the attainment of national and state ambient air quality standards.  It is 
also an essential tool in developing regulations and control strategies to 
fulfill ARB’s mission to promote and protect public health, welfare, and 
ecological resources through the effective and efficient reduction of air 
pollutants while recognizing and considering the effects on the economy of 
the state. 
 
An emissions inventory (for any source category) can be calculated, at the 
most basic level as the product of an emission rate, expressed in grams of a 
pollutant emitted per some unit of source activity, and a measure of that 
source’s activity.  The following expression illustrates this basic relationship 
between the emissions rate and source activity used to calculate emissions:   

Emission Factor X Source Activity = Emissions 

For on-road motor vehicles, emissions rates are typically expressed as mass 
of pollutant emitted per mile driven per day, per vehicle per day, or per trip 
made, depending on the emissions process being analyzed.  An emissions 
process for a motor vehicle is the physical mechanism that results in the 
emissions of a pollutant (e.g., the combustion of fuel, the evaporation of 
fuel, tire or brake wear, or the initial start of an engine). 
 
The Air Resources Board (ARB) developed an EMission FACtors (EMFAC) 
model to calculate statewide or regional emissions inventories by 
multiplying emissions rates with vehicle activity data from all motor 
vehicles, including passenger cars to heavy-duty trucks, operating on 
highways, freeways, and local roads in California.  
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1.2 EMFAC2014 
 
Over the years, tougher emissions standards have been met with 
technological solutions of increasing complexity.  As a result, the emissions 
estimation models have also grown in size and complexity. 
 
EMFAC2014 is the latest emissions inventory model that calculates 
emissions inventories for motor vehicles operating on roads in California. 
EMFAC2014 represents the next step forward in the ongoing improvement 
process for the EMFAC series of emissions estimation models, and reflects 
the ARB’s current understanding of how vehicles travel and how much they 
pollute.  The EMFAC2014 model is needed to support the Air Resources 
Board’s (ARB) regulatory and air quality planning efforts and to meet the 
Federal Highway Administration’s transportation planning requirements. 
 
The EMFAC2014 model can be used to show how California motor vehicle 
emissions have changed over time and are projected to change in the 
future.  This information helps ARB evaluate prospective control programs 
and determine the most effective, science-based proposals for protecting 
the environment.   EMFAC2014 includes the latest data on California’s car 
and truck fleets and travel activity.  New forecasting methods have been 
incorporated for developing vehicle age distributions and estimating vehicle 
miles traveled.  The model also reflects the emissions benefits of ARB’s 
recent rulemakings, including on-road diesel fleet rules, Advanced Clean 
Car Standards, and the Smartway/Phase I Heavy Duty Vehicle Greenhouse 
Gas Regulation. The model also includes updates to truck emission factors 
based on the latest surveillance data.  More details about the updates in 
emissions calculation methodology and data are available in the 
EMFAC2014 Technical Support Document (not yet released). 
 
ARB staff has departed from using Fortran (the legacy programming tool 
that was used for EMFAC2011-LDV and previous versions of EMFAC) and 
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has rebuilt the model using Python and MySQL software.  This was done for 
several reasons:  

• To make the model more user friendly; 
• To make it easier to update the model code and associated data & 

methodologies into the future; 
• To provide greater flexibility for incorporating and assessing future 

new rules;  
• To provide the capability for developing more detailed emissions 

inventories; 
• To make it easier to transfer EMFAC output to other tools.   

 
In EMFAC2014, all the functionalities of the three modules in EMFAC2011 
(LDV, HD, & SG), as well as the project-level assessment tools, have been 
integrated into one single package.   

Figure 1-1.  EMFAC2014 Overall Flow 

 

 
 
 
 

7 
 



 

 

1.3 ABOUT THIS DOCUMENT 
 
The purpose of this EMFAC2014 User’s Guide is to familiarize users with the 
features and controls in the EMFAC2014 model.  For more information 
regarding the methodologies used in EMFAC2014 to estimate emissions 
and emission rates, please refer to the EMFAC2014 Technical 
Documentation. 
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2 POLLUTANTS AND PROCESSES MODELED 
 
This section describes the pollutants and emissions processes currently 
modeled in EMFAC2014. 

2.1 POLLUTANTS  
 
The model calculates emissions factors and emissions inventories for the 
following primary pollutants:  

• Carbon monoxide (CO) 
• Nitrogen oxides (NOx) 
• Hydrocarbons (HC):  HC can be expressed as TOG (total organic gases), 

ROG (reactive organic gases), THC (total hydrocarbon), or CH4 
(methane).  The THC class includes compounds with H and C atoms only, 
carbonyls and halogens are not included in the class.  The TOG class 
includes all organic gases emitted into the atmosphere.  The ROG class is 
same as EPA’s VOC (volatile organic compounds) definition and does not 
contain compounds exempt from regulation.  

• Carbon dioxide (CO2) 
• Particulate matter (PM):  PM estimates are provided for total suspended 

particulates for particulate matter 10 microns or less in diameter 
(PM10), and particulate matter 2.5 microns or less in diameter (PM2.5). 

• Fuel consumption:  Although, this is not a pollutant, fuel consumption is 
calculated based on the emissions of CO, CO2 and THC using the carbon 
balance equation.   

• Oxides of sulfur (SOx):  Emissions of oxides of sulfur are a function of the 
sulfur content of fuel.  The model calculates these emissions by 
multiplying the fuel consumption by the weight fraction of sulfur in a 
gallon of fuel.    
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2.2 EMISSIONS PROCESSES  
 
Emissions (especially HC) emanate from a vehicle during all hours of the 
day.  The magnitude of these emissions varies with what is happening with 
the vehicle, such as running on the road, idling at a loading zone, sitting 
outside in the sun, or just starting.  Emissions processes account for all 
emissions of a vehicle across all hours of the day, regardless of whether the 
vehicle is in motion or whether or not it has been started. The types of 
emissions processes in the model are: 

• Running Exhaust Emissions that come out of the vehicle tailpipe while 
traveling on the road.   

• Idle exhaust emissions that come out of the vehicle tailpipe while it is 
operating but not traveling any significant distance.  This process 
captures emissions from heavy-duty vehicles that idle for extended 
periods of time while loading or unloading goods.  Idle exhaust is 
calculated only for heavy-duty trucks.   

• Start Exhaust Tailpipe Emissions that occur when starting a vehicle.  
These emissions are independent of running exhaust emissions and can 
be thought of as emissions associated with starting a vehicle.  The 
magnitude of these emissions is dependent on how long the vehicle has 
been sitting prior to starting.  (Start emissions are only estimated for 
gasoline fueled vehicles.  More details can be found in the EMFAC2014 
Technical Support Document). 

• Diurnal HC Emissions that occur when rising ambient temperatures 
cause fuel evaporation from vehicles sitting throughout the day.  These 
losses are from leaks in the fuel system, fuel hoses, connectors, as a 
result of the breakthrough of vapors from the carbon canister.  If a 
vehicle is sitting for a period of time, emissions from the first 35 minutes 
are considered as hot soak and emissions from the remaining period are 
considered as diurnal emissions, provided that the ambient temperature 
is increasing during the remaining period of time.   
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• Resting Losses that occur while the vehicle is sitting are caused by fuel 
permeation through rubber and plastic components.  Emissions are 
counted as resting loss emissions if the vehicle has not been operated 
for 35 minutes and has been stationary, while the ambient temperature 
is either constant or decreasing.   

• Hot Soak Evaporative HC emissions that occur immediately after a trip 
are due to fuel heating as an engine remains hot for a short time after 
being switched off.  In older, carbureted vehicles these emissions are 
attributed to vapor losses from the carburetor float bowl.  In newer, 
fuel-injected vehicles, these vapor losses come from leaky fuel injectors 
or from fuel hoses.   

• Running Loss Evaporative HC Emissions that occur are a result of hot fuel 
vapors escape from the fuel system or overwhelm the carbon canister 
while the vehicle is operating. 

• Tire Wear Particulate Matter Emissions that originate from tires as a 
result of wear.  

• Brake Wear Particulate Matter Emissions that originate from brake 
usage.   
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3 INSTALLATION AND CONFIGURATION OF EMFAC2014 

3.1 SYSTEM REQUIREMENTS 
 

• Operating System: Microsoft Windows 
• At least 2 GB of free space is required to install EMFAC2014. 
• The space needed to run EMFAC2014 depends on the level of detail in 

the output, the number of sub-areas and calendar years selected, and 
the number of runs. At least 50 GB free space is recommended. 

• The model was tested on the following system 
o Processor: Intel® Core™ 2 Duo CPU E8400 @3.00GHZ 
o Installed memory (RAM): 4.00 GB (3.90 GB Usable) 
o System type: 64-bit Operating System 
o Windows Edition: Windows 7 Enterprise 
o The model will run faster with a faster CPU and more RAM. 

3.2 PRE-INSTALLATION NOTES 
 

• The “full” (not “typical”) installation of the MySQL Community Server 5.x 
must be installed on your local computer prior to installing EMFAC2014. 
The software can be downloaded from 
http://www.mysql.com/downloads/mysql/.  Install the MySQL Server 
and MySQL workbench on your local computer following the installation 
instructions and make sure to write down the password for the “root” 
account.  

• The model has been tested on MySQL 5.5 and 5.6.  Older versions of 
MySQL should also work but have not been tested. 
o If MySQL is already installed, the existing MySQL may work, as long as it was 

installed through the full installation.  You will still need to remember and input 
the password for the root account. 

o If MySQL needs to be reinstalled, the existing version should be uninstalled first. 

• EMFAC2014 was developed using Python version 2.7 and MySQL 
Community Server (5.6).  Python was used to develop the program, and 
MySQL was used to manage the data. Python is not required on the 
user’s computer to run the model. 
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• Please note that this User’s Guide assumes the default directory for the 
model is “C:\emfac2014\”.  The model should also work in a directory 
other than this default. 
 

 
 
 
 
 
 
 
 

3.3 MODEL INSTALLATION 
 

1. Extract the EMFAC2014 package to a folder of your choice on your local 
drive.  This user’s guide assumes the package is extracted or copied to 
the C: root directory. 

2. Right click on “emfac.exe”, in the installation directory 
("C:\emfac2014\emfac.exe") to create a shortcut or pin it to the taskbar 
or the start menu.  

3.4 MODEL CONFIGURATION 
 

1. Double click “emfac.exe” within the installation directory, or click the 
icon on the taskbar or start menu, to start EMFAC2014.  The program will 
display a page that asks users to configure MySQL settings first using the 
MySQL Configurator.  Ignore the Microsoft Windows security warning 
window if it shows up. 

2. Click the “Launch MySQL Configurator” button to bring up the pop-up 
window shown below.  This configuration is needed for installation of an 
updated model or when the configuration of MySQL is changed. 

Note! 

Please do not make any changes to the EMFAC default 
database on the MySQL server.  The model may fail or 
generate erroneous results if changes are made to the 
database. 
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3. Keep “Host,” “Port,” and “Username” unchanged, and the “Password” 

will be the one you supplied upon installation of MySQL for the root 
account.   

4. Click “Test” to test the configuration. 
5. Click “Save” only when both the connection and directory are set 

correctly. Repeat the configuration steps if any mistake is made. 
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6. EMFAC2014 will close and will need to be restarted. 
7. Restart the model and on the following screen click “Import EMFAC 

Default Database”. 
 

 
 
8. After the import is completed, close the program and reopen it.  
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4 GETTING STARTED WITH EMFAC2014 

4.1 GENERAL TIPS 
 
• The EMFAC2014 console shows the status of the model and error 

messages, if any.   
• Consecutive items can be selected by shift-clicking and non-consecutive 

items can be selected by control-clicking in the list boxes. 
• The unit for fuel in the output is 1000 gallons/day and the unit for all 

other pollutants in the emissions inventory is tons/day. 
 
 
 
 

 
 
 
 
 
 
 

4.2 GRAPHICAL USER INTERFACE  

4.2.1 MENUS 
 
There are four menus in the parent window of EMFAC2014: “File”, “Run”, 
“Tools” and “Help”. 

• The File Menu has four actions: “New” (new run), “Open” (open a saved 
run specification), “Save” (save a run specification), and “Exit.”  Upon 
starting the program, the program automatically assumes the user is 
creating a new run and thus the parent window displays the Home 

Note! 

1. Do not close the console while the model is running. 
2. Limit the number of areas and calendar years and level of 

details selected for one run to manage the run-time of the 
current run and the size of the output.   

3. Splitting big runs into small runs is strongly recommended.  
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Screen.  One may choose to open a previous run by selecting “Open” in 
the File Menu and then selecting the appropriate file. 

• The Exit action of the File Menu will only work in EMFAC2014 if a 
calculation is not being made.  If calculations are occurring, cancel the 
run first, and then exit. 

• The Run Menu has one action: “Run EMFAC.”  
• The Tools Menu has one action: “MySQL Configurator.” 
• The Help Menu has an “About…” action that will tell the user which 

version of the model is running. 

4.2.2 HOME SCREEN, RUN MODES AND TYPES 
 

• The Home Screen is automatically displayed after the model starts or 
when “New” is selected from the File Menu. 

• “Run Mode” and “Run Type” are the selection options in this “New” tab. 
There are two different Run Modes: “Emissions” and “Emission Rates.”  

• Under the “Emissions” run mode, two Run Types are available. “Default 
Activity” runs use default EMFAC activity data, while the “Custom 
Activity” run type allows the users to use their own activity data to run 
the model.  The “Custom Activity” run type was formerly known as “SG” 
or “Scenario Generator”.  It can be used to generate an input activity 
data file template or to load custom activity data to produce an 
emissions inventory for transportation planning, a SB375 report, etc.. 

• Under the “Emission Rates” run mode, only one Run Type is available.  
The ‘’PL” run type can be used to calculate emissions rates for project-
level assessments. 
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5 GENERATING EMISSIONS INVENTORIES 
For regional analyses (as opposed to project-level analyses), EMFAC2014 can be 
run in two different modes dictated by the travel activity data that are used. 
 
Default Activity Mode.  EMFAC 2014 uses historical fuel sales to estimate vehicle 
miles traveled (VMT) as its default to facilitate fuel-based inventory analyses.   
 
Custom Activity Mode.  It is necessary to use the latest regional motor vehicle 
travel activity data developed by local planning agencies to generate the regional 
on-road emissions for State Implementation Plans (SIPs).  Thus, for SIP criteria 
pollutant (planning inventory) analyses, EMFAC2014 has the ability to allow the 
user to replace the fuel-based default data with user-supplied data from 
metropolitan and regional planning agencies. 

 

5.1 USING DEFAULT ACTIVITY MODE 
 
In this section we explain how to accomplish a Default Activity Emissions 
run, which is typically performed for fuel-based emissions inventory 
analyses, either from the Home Screen or by loading an EMFAC2014 “.ers” 
file, saved from a previous run.  The run parameters for a default emissions 
run is summarized in Appendix 1. 

5.1.1 STARTING A DEFAULT ACTIVITY RUN 
1. Go to the Home Screen by either restarting the model or clicking “New” 

in the File Menu. 
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2. Pick “Emissions” and “Default Activity” and click “Start”. 

a. This takes the user to a window with four tabs; the Area Tab, the Time Tab, the 
Vehicles Tab, and the Output Tab.   

b. Each tab presents options for the user to customize for the model run. 
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5.1.2 AREA TAB 
• The Area Tab’s list boxes allow the user to choose different area types 

and areas for analysis.  Please refer to Appendix 2 for area definitions. 
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• The user may pick only one Area Type, but has the option of selecting 

multiple Areas within the chosen Area Type by holding the Ctrl key while 
clicking on an area. 

• “Air Basin” has been selected in the following window. 
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5.1.3 TIME TAB 
• In the “Time” tab, a single Calendar Year or multiple years may be 

selected; however, only one Season or Month may be selected for each 
run.   
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5.1.4 VEHICLES TAB 
• In the Vehicle Class list box, the user can select the vehicle classes of 

interest.  All vehicles can be selected by clicking “Select All”.  Both the 
EMFAC2007 and the EMFAC2011 Vehicle Classes are available.  Please 
refer to Appendix 3 for definitions of vehicle categories. 

• The data can be output in either “By Model Year” or “Aggregated” form.   
o Choosing By Model Year and selecting a large number of Model Years will 

considerably increase the size of the output. 

• The user can choose to output the data “By Fuel” (for output by each 
fuel type) or “Aggregated” (for combined output only). 

• The user can also choose to output the data “By Speed” (for output at 
each speed) or “Aggregated” (for combined output only).  
o Choosing “By Speed” will considerably increase the size of the Output Table.  

 

 
 

25 
 



 

 

5.1.5 OUTPUT TAB 
• The “Pollutants” group box allows the user to choose which Pollutants 

data should be included in the output. 
• The “Activities” group box indicates which Activity data can be selected 

to be included in the output. 
• The “Options” group box allows the user to choose “Output by Process” 

to output data per emissions process (e.g., Running Exhaust Emissions, 
or Start Exhaust Tailpipe emissions) or to choose “Output by Cat-
NonCat” for output per Catalyst-Equipped and Non-Catalyst Equipped 
groupings. 

• The “Save Data” group box selection will indicate whether the output 
from the current run will be saved for future use.   

• The “Output Directory” group box allows users to specify a different 
directory to hold the output files other than the default directory at 
“C:\emfac2014\Output” by clicking the “Change Directory” button. 

• The standard output format for a Default run is “CSV” (comma-
separated text files).  The format is different than the CSV report output 
in previous versions of EMFAC.  The output files will have a numerical 
timestamp in the name of the files.  
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5.1.6 STARTING THE MODEL RUN  
1. Limiting the number of calendar years, areas, and the level of detail 

selected will reduce the free space required for a run.  This size decreases 
considerably if you deselect some of the options such as “By Hour”, “By 
Model Year”, etc..  

2. Click “Run EMFAC”, in the Run Menu, or the “Run” button at the lower 
right corner of the Output tab to start the model run.  

5.1.7 SAVING THE RUN SPECIFICATION 
• Save the “Run Specification” (as “.ers” files) for future use after all the 

run parameters have been determined.  Click “Save” in the file menu or 
click “OK” in the pop-up window after the run button is clicked to save 
the .ers file. 
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5.1.8 ONCE THE RUN HAS STARTED 
• The time it takes to finish a run depends on how many sub-areas and 

calendar years were selected, the aggregation level specified for the 
output files, and the performance of the computer.  

• The model run can be stopped by clicking “Cancel” in the EMFAC2014 
Window. 

• The status window can be minimized by minimizing the main window. 
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• The following window provides the names and locations of the output 
files generated after the run has finished. 

 
 
 
 

 
 

5.1.9 START DEFAULT RUN USING A SAVED .ERS FILE  
1. Click “Open” in the File Menu to load the file. 
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2. The run parameters will be loaded to the model and can be modified 
and saved as a new .ers file by clicking “Save” in the File Menu. 

5.1.10 SAVE OUTPUT DATA FROM A RUN FOR FUTURE USE 
As a way to reduce computational time, the model allows the output data 
from the current run to be saved for future use if the “save data from this 
run for future use” is selected in the output tab.  This works for both 
Default Activity Runs as well as Custom Activity (SG) runs. 
Data saved from previous runs can be used if one or more of the three 
criteria are met: 

1. The current run has exactly the same run parameters as one of the 
previous runs that have output saved. 

2. The run parameters (Calendar Years, Areas) of the current run are a 
subset of parameters of one of the previous runs that have output 
saved. 

3. The current run has fewer details or is more aggregated than the 
previous runs with saved output. 
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User waiting time will be significantly reduced when saved output from 
previous runs are used for the current run. If the model can pull in some 
data from the saved Output files, that will be much faster than recalculating 
all of the data.  

5.2 USING CUSTOM ACTIVITY MODE (SG)  

5.2.1 BACKGROUND 
The Custom Activity Mode of EMFAC2014, is designed to perform emissions 
assessments for determining conformity with the state implementation 
plan and for compliance with SB375 targets.   
 
Both types of assessments are most often done by various planning 
agencies throughout California.  These assessments require the user to 
create custom activity data files containing vehicle miles travelled (VMT) 
and/or speed profile data.  This customized activity data will then be used 
for scaling the default vehicle emissions produced by EMFAC2014.  
Previously, this function was performed by EMFAC2011-SG (“Scenario 
Generator”) or the What If Scenarios (WIS) generator in EMAC2007 and 
older versions. 
 
EMFAC2014 is able to import activity templates generated with 
EMFAC2011-SG.  In addition, EMFAC2014 allows the user to generate 
activity templates that contain daily VMT (either as totals or broken out by 
vehicle-tech) and/or hourly speed profiles.   

5.2.2 TYPES OF CUSTOM ACTIVITY DATA 
There are two custom activity input formats supported by EMFAC2014: 
EMFAC2011-SG format and EMFAC2014 format.  Both formats are provided 
as Excel workbooks.  In excel, the entire spreadsheet file is known as a 
“workbook”; an individual tab within the workbook is known as a 
“worksheet”.   
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For both formats, the names of the worksheets MUST be exactly as 
produced from either EMFAC2011-SG or EMFAC2014.  Table 1 shows a list 
of the worksheet names and the types of data each contain.  EMFAC2014 
uses these worksheet names to identify what type of data is present. 
Worksheets with any other names will be ignored.  
 
EMFAC2014 can import multiple sets of activity data at one time; however, 
they must be the same type: they all must be either the EMFAC2011-SG 
type or the EMFAC2014 type.  
 
The EMFAC2011-SG format is saved in Excel 2003 format (suffix is “*.xls”).  
If you have an existing 2011 SG formatted data set that you have edited 
and saved in the Excel 2007 format (suffix is *.xlsx) , you will need to re-
save it in the Excel 2003 format (suffix is *.xls) in order for EMFAC2014 to 
read it.  
 
The user must provide either daily total VMT or daily total VMT by vehicle-
tech.  Speed fraction profiles are optional.   
 
The “scenario_base_inputs” worksheet determines which data will be read 
in as custom data;  columns H, I, and J determine whether the data 
contained in the scenario_base_input, scenario_vmt_by_vehcat, and 
scenario_speed_profiles contain “default” data or “user” data (i.e., custom 
data).  One or more of the three columns should contain the “user” 
designation.  Otherwise, EMFAC2014 will treat it as an input file for a 
default activity run.  In other words, if all three columns contain the word 
“default”, EMFAC2014 will post a message saying that you will need to run 
a default run from the main EMFAC2014 screen.   
 
EMFAC2014 can only process data for multiple scenarios with the SAME 
type of area.  That is, one cannot run a scenario with the SCAG MPO and 
the Lake Tahoe Air Basin, since the first is an MPO and the second is an Air 
Basin. 
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The EMFAC2014 custom activity data format is always saved in the Excel 
2007 format (suffix is “*.xlsx”).  EMFAC2014 will produce a template with 
the default VMT and the optional hourly speed fraction profile data.   
 
The EMFAC2014 custom activity data format is similar to that of 
EMFAC2011-SG, except the scenario number and title columns are 
removed.  
 

The settings worksheet is used for two purposes: to specify the 
season/month value for the desired emissions run, and to indicate whether 
or not the template is for SB375 conformity purposes.  This is important to 
differentiate because SB375 requires the Accelerated Clean Cars and the 
Low Carbon Fuel Standards to be turned off in the calculations made for the 
emissions inventory that will be generated.  The Accelerated Clean Cars 
program assumes a different fleet mix and vehicle miles travelled, so 
templates produced for SB375 purposes will not match output that was not 
specified as for SB375 purposes.  
 
Table 5-1 summarizes the worksheets contained in the activity template for 
each of the EMFAC2011-SG and EMFAC2014 formats. 
 

Table 5-1. Worksheets in Activity Templates 

Format Worksheet Name Description 

EMFAC2011-SG regional_scenarios Contains run parameters: area type, area, calendar year, 
and season 

EMFAC2011-SG scenario_base_inputs Whether default or user input will be used and total daily 
VMT 

EMFAC2011-SG scenario_vmt_by_vehcat VMT by vehicle type and fuel 

EMFAC2011-SG scenario_speed_profiles Daily speed profile 

EMFAC2014 settings Season/month and whether it is a SB375 template 

EMFAC2014 daily_total_vmt Daily total VMT 

EMFAC2014 daily_vmt_by_veh_tech Daily VMT by vehicle type and fuel 

EMFAC2014 hourly_fraction_veh_tech_speed Hourly speed profile 

 

5.2.3 GENERATING A CUSTOM ACTIVITY TEMPLATE 
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The run parameters for generating a custom activity template are 
summarized in Appendix 4. 

1. Select the “Custom Activity (SG)” Run Type, and then “Generate Custom 
Activity Template” in the pop-up dialog box that appears. 

 

 
 
2. Click “Start”.  The following window will appear: 
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3. In the Area tab, you can change the area type by clicking where “Sub-

Area” appears above.  
4. Select one or more Areas, however, the more areas selected, the longer 

the runtime will be.  If you hold down either the shift or the control key 
while clicking, you can select multiple areas.  

5. Click “Next” or the Time tab. 
6. Select one or more calendar years, however, the more years you select, 

the longer runtime will be. 
7. Select “Season” or “Month” and then specify which Season or Month 

you would like to use. 
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8. Click “Next” or the VMT tab. 
9. Select the VMT data type you would like for inputting the data into the 

template you will generate. 
10. Select “Custom Hourly Speed Fractions” if your own speed profile will be 

used. 
11. Choose whether or not the template will be for SB375.  
12. Click the “Generate Template” button.  
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13. Select where the template will be saved. 
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14. Click “Save” and the model will start generating the template. 
 

 

 
15. The following window will be shown after the template is generated. 
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5.2.4 MODIFYING CUSTOM ACTIVITY TEMPLATES 
Custom activity templates are generated in a Microsoft Excel format.  Users 
can use Excel to edit the data to meet their needs.  Before using the activity 
templates, there are several things to know: 

• EMFAC2011-SG Templates are always in Excel 2003 format, and have 
the suffix “xls”. 

• EMFAC2014 Templates are always in Excel 2007 format, and have the 
suffix “xlsx”. 

• The template worksheet names for either of these types of custom 
activity must not be changed.  These names are used to identify what 
type of data is present.  Worksheets with any other names will be 
ignored.  
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• The order and names of columns should not be changed on worksheets 
and data rows should not be deleted.  

• EMFAC2014 Templates have a worksheet named “Settings”:  this is 
primarily used to define the season or month being run and whether the 
custom activity template contains activity for a conformity assessment 
or a SB375 assessment.  The field with the season/month can be 
changed; the field with the SB375 setting cannot be changed.  

• For worksheets broken out by vehicle-tech, all vehicle-tech types must 
be present.  If you generate an EMFAC2014 custom activity template, all 
necessary vehicle-techs are provided. 

• Speed fractions should add up to one for each hour in the 
“Hourly_Fraction_Veh_Tech_Speed” tab. 

• The EMFAC default speed profile will always be used for the following 
vehicle types: 

UBUS - Gas 
UBUS - Dsl 
PTO - Dsl 
T7 Other Port - Dsl 
T7 POAK - Dsl 
T7 POLA - Dsl 

 T7 SWCV - Dsl 
• “Default” in the “Scenario_Base_Inputs” tab of EMFAC2011 files means 

that the model will use EMFAC2014 default data not EMFAC2011 default 
data; EMFAC2014 contains EMFAC2014 default data, not EMFAC2011 
default data.   

• One or more of the “VMT Profile”, the “VMT by Vehicle Category”, and 
the “Speed Profile” columns in the “Scenario_Base_Input” tab in the 
EMFAC2011 files needs to be designated as “User” for the EMFAC2014 
model to process the input data.  EMFAC2011 files, in which all of the 
three columns are “Default,” will be rejected; a default inventory can be 
produced using the EMFAC2014 Default Activity run type.  

5.2.5 RUNNING EMFAC WITH A CUSTOM ACTIVITY TEMPLATE 
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The run parameters for generating a customized activity inventory are 
summarized in Appendix 5. 

 

1. Return to the Home Screen by selecting “File”, “New” from the menu 
and select “Custom Activity (SG)”. 

2. Select “Load Custom Activity File” and click the “Start” button. 
 

 
 

3. Select the type of Custom Activity Template, either EMFAC2011 or 
EMFAC2014. 

4. Select SB375 run if an EMFAC2011 file is to be imported for a SB375 run.  
SB375 will be automatically selected, if it is already specified as a SB375 
run, after loading an EMFAC2014 input data file. 
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5. Click the “Load Custom Activity” button and find the file.  You can hold 
down either the shift or control keys during selection to load more than 
one file at a time.  
 

 

 

 

 

 

 

 
 

6. Select on the desired file and then click “Open”.  Click “Ok”.  

Note! 

Files with different area types or seasons or SB375 settings 
cannot be loaded together. 
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7. Information about the loaded file is displayed on the window.  Make 
sure the correct file has been selected.  
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8. In the output tab, pick the Report Type, choose whether or not to save 
the output data for future use, and change the output location if 
desired.   

 

 
 
9. An SB375 report will only be generated, if it is specified to be a SB375 

run. 
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10. Click “Run” to start the calculation. 
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11. After the run completes a window will be shown that will provide the 
Output File location and file name. 
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6 GENERATING EMISSIONS RATES  
 
This section will describe the actions needed to generate emissions rates 
for a Project-Level Assessment or for projects using project specific data.  
Please note that all emissions rates for project-level assessments can now 
be obtained from a single source, the EMFAC2014 model.  This is in 
contrast to EMFAC2011, for which different data sources and tools were 
needed to obtain emissions rates for project-level analysis. 

6.1 STARTING A PROJECT-LEVEL ASSESSMENT EMISSIONS 
RATES RUN 

 
The run parameters for generating emissions rates are summarized in Appendix 6. 
 

1. Go to the Home Screen by either restarting the model or clicking “New” 
in the File Menu. 

2. Pick Emission Rates and PL as the Run Type and click “Start”. 
a. This takes the user to a window with four tabs; the Area Tab, the Time Tab, the 

Vehicles Tab, the Meteorology Tab, and the Output Tab.   
b. Each tab presents options for the user to customize the PL run. 
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6.1.1 AREA TAB 
• The user may pick only one Area Type, but has the option of selecting 

multiple Areas from within the chosen Area Type. 
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6.1.2 TIME TAB 
• In the “Time” tab, a single Calendar Year or multiple years may be 

selected; however, only one Season or Month may be selected for each 
run.   

• Emissions rates vary by season or month as a result of variation in the 
Fuel Reid Vapor Pressures by month or season. 
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6.1.3 VEHICLES TAB 
• The user can select the vehicle classes of interest.  All vehicles can be 

selected by clicking “select all”.   Emissions rates can also be provided at 
various sub-levels using the EMFAC2011 or EMFAC2007 vehicle 
groupings and selections such as truck/non-truck, or truck1/truck2/non-
truck levels.  Please refer to the definitions of vehicle categories in 
Appendix 3. 

• The data can be output in either the “By Model Year” or the 
“Aggregated” format.   
o The “By Model Year” option is for projects for which the activity data by model 

year must be made available.  
o The “Aggregated” option is for projects for which only the combined total and 

not the activity data by model year is needed.   

• The user can choose to output the data “By Fuel” (for output by each 
fuel type) or “Aggregated” (for combined output only). 
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• In a PL Run, Speed bins must be selected.  
 

 
 

6.1.4 METEOROLOGY TAB 
• PL Runs require the input user-defined meteorology data 

o The data must be input in temperature (Fahrenheit) and relative humidity 
(percentage without % sign) pairs with one pair in one row.  See examples in the 
following screen shot. 
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6.1.5 OUTPUT TAB 
• The Pollutants group box allows the user to choose which Pollutants 

data should be included in the output. 
• The Output Directory group box allows users to specify a different 

directory to hold the output files by clicking the “Change Directory” 
button. 
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6.2 STARTING THE PROJECT-LEVEL MODEL RUN  
 

1. Click “Run EMFAC”, in the Run Menu, or the “Run” button at the lower 
right corner of the Output tab to start the model run.  

• Save the “Run Specification” (as .ers file) for future use after all run 
parameters have been determined.  Click “Save” in the File Menu or 
click “OK” in the pop-up window after the run button is clicked to save 
the .ers file. 
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• The model run can be stopped by clicking “Cancel” in the EMFAC2014 

Window. 
• The pop-up window provides the names and locations of the output files 

generated after the run has finished. 
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7 DESCRIPTION OF OUTPUT 
 

By default, the output files are saved in the “output” folder under the 
EMFAC installation directory.  Users can specify another folder to hold 
these files.  Output file names, which are generated automatically, start 
with the name of .ers files or the names of the custom activity input files, 
followed by output type and a timestamp suffix. 
 

7.1 CSV (COMMA-SEPARATED VALUES) 
 
The standard output format from EMFAC2014 is CSV (comma-separated 
values), which is not to be confused with the CSV report from the previous 
versions of EMFAC. CSV is a common, relatively simple file format that is 
widely supported by consumer, business, and scientific applications.  
 
For emissions runs, the model may output up to four CSV files for 
emissions, VMT, trips and population, depending on what users choose 
under the Output tab.  
 
For PL runs, the output is a single file containing emissions rates.  The 
speed_time column in the emissions rates report contains different values 
for different processes.  It is a speed bin for running exhaust and it is time 
in minutes that the vehicle has been sitting prior to starting for start 
emissions. 
 
The start activity is defined differently for heavy duty diesel trucks than for 
other vehicles.  Start emissions of diesel heavy-duty truck are modeled 
separately in EMFAC2014.  More details can be found in the EMFAC2014 
Technical Support Document.  
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Table 7-1 provides a summary of the columns in the emissions, activity, and 
emission rates CSV output files.  Table 7-2 lists the emissions processes in 
the emissions rates output files. 
 
Table 7-1.  Summary of Columns in CSV output Files 

Column Name Description 
calendar_year Calendar Year(s) between 2000 -2050 
season_month annual, summer, winter or one of the twelve months 
sub_area Sub Area as defined in Appendix 2 
vehicle_class Vehicle class as defined in Appendix 3 
fuel Gasoline, diesel, or other fuel types 
model_year Model year 
hour One of the 24 hour 
speed Speed bin from 5 to 90 with 5 incremental 
process Emission process 
cat_ncat With or without catalytic converter 
pollutant Pollutants 
emission Amount of emissions 
vmt Vehicle-miles traveled 
trips Number of trips 
population Vehicle population 
temperature Temperature in Fahrenheit 
relative_humidity Relative humidity in percentage 

speed_time 

For running exhaust (RUNEX), “speed_time” field provides the 
speed bin ranging from 5 mph to 90 mph. For the start process, 
this field provides the soak time prior to vehicle starting in 
minutes, ranging from 5 minutes to 720 minutes. For other 
processes where emissions rates do not depend on speed bin or 
soak time, this field is blank. 

emission_rate Emissions per unit of activity 

 
 
Table 7-2.  Emissions Processes in Emissions Rates Files 

Emission Process Description 

RUNEX Running Exhaust 

IDLEX Idle Exhaust 

STREX Start Exhaust 

RUNLOSS Running Loss 
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PRESTLOSS Partial Day Resting Loss 

MDRESTLOSS Multi-Day Resting Loss 

RESTLOSS Resting Loss 

PDIURN Partial Day Diurnal Loss 

MDDIURN Multi-Day Diurnal Loss 

DIURN Diurnal Loss 

PMTW PM Tirewear 

PMBW PM Brakewear 

 

7.2 PLANNING INVENTORY REPORT 
 
The Planning Inventory Report is an Excel 2007 formatted workbook that 
contains emissions and activities which are summed by area, calendar year, 
and vehicle-tech type.  It provides a column for every pollutant and 
process, with sub-total columns at the appropriate places.  It provides a 
summary worksheet for a given area and another worksheet entitled “By 
Sub-Area” that is broken out by the sub-areas within the area specified by 
the user, if selected.  If a run is only for a single sub-area, or if an area only 
has one sub-area (such as the Lake County Air Basin), only one data 
worksheet will be produced. This report includes a “Read_me” tab and a 
“Glossary tab” which provides information on the report type, the date and 
time the report was generated, and an explanation of the columns. 
 

7.3 SB375 REPORT 
 
The SB375 report is an Excel workbook that is a sub-set of the Planning 
Inventory Report described above.  It is limited to four vehicle types, CO2 
emissions, and the related activity. The only vehicle-tech types included in 
this SB375 report are: 

• LDA - DSL 
• LDA - GAS 
• LDT1 - DSL 
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• LDT1 - GAS 
• LDT2 - DSL 
• LDT2 - GAS 
• MDV - DSL 
• MDV – GAS 

7.4 CTF REPORT 
 
The CEIDARS Transfer Format (CTF) is a report used internally by the ARB to 
import emissions inventory data into an internal emissions inventory 
database and forecasting system.  The area and sub-area fields, produced 
by EMFAC, are replaced with the County-Air Basin-District coding system, 
and the Emissions Inventory Code (EIC) system replaces the vehicle-tech 
type and the processes.  Appendix 7 provides a description of the fields in a 
CTF file. 
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APPENDIX 1 SUMMARY OF RUN PARAMETERS FOR GENERATING DEFAULT 
EMISSIONS INVENTORY 

Tab Run Parameters Description 

Area 
Area Type One of the area types can be picked. 

Area  One or more areas can be selected for one run.   

Time 

Calendar Year Between 2000 and 2050.  One or more calendar years can be selected for one run. 

Season/Month One of the three seasons (annual, summer, winter) or one of the 12 months can be selected for one run. 

Day or Hour Aggregation Output emissions by day or by hour. 

Vehicles 

Vehicle Class type Output by EMFAC2011 vehicle class or EMFAC2007 vehicle class.   

Vehicle Class One or more vehicle classes can be picked for one run. 

Model Year Aggregated or by model year in output.  One or more model years can be selected if by model year is picked. 

Fuel Aggregated or by fuel in output. 

Speed Aggregated or by speed in output. 

Output 

Pollutants Pollutants in output. 

Activities Pick one or more of the activities (VMT, vehicle population, or trips) to be included in output files. 

Output by process Whether output by process. 

Output by Cat/NonCat Whether output by Cat/NonCat. 

Save data for future use Users can get results faster in the future if data from previous runs are saved and used. 

Output Directory Where to save output files. 
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APPENDIX 2 DEFINITION OF AREAS 
Sub-Area County Name Air Basin Name Air District Name MPO MPO Name 

Alameda (SF) ALAMEDA SAN FRANCISCO BAY AREA BAY AREA AQMD MTC Metropolitan Transportation Commission 

Alpine (GBV) ALPINE GREAT BASIN VALLEYS GREAT BASIN UNIFIED APCD 
  

Amador (MC) AMADOR MOUNTAIN COUNTIES AMADOR COUNTY APCD 
  

Butte (SV) BUTTE SACRAMENTO VALLEY BUTTE COUNTY AQMD BCAG Butte County Association of Governments 

Calaveras (MC) CALAVERAS MOUNTAIN COUNTIES CALAVERAS COUNTY APCD 
  

Colusa (SV) COLUSA SACRAMENTO VALLEY COLUSA COUNTY APCD 
  

Contra Costa (SF) CONTRA COSTA SAN FRANCISCO BAY AREA BAY AREA AQMD MTC Metropolitan Transportation Commission 

Del Norte (NC) DEL NORTE NORTH COAST NORTH COAST UNIFIED AQMD 
  

El Dorado (LT) EL DORADO LAKE TAHOE EL DORADO COUNTY APCD TMPO Tahoe Metropolitan Planning Organization 

El Dorado (MC) EL DORADO MOUNTAIN COUNTIES EL DORADO COUNTY APCD SACOG Sacramento Area Council of Governments 

Fresno (SJV) FRESNO SAN JOAQUIN VALLEY SAN JOAQUIN VALLEY UNIFIED APCD COFCG Fresno Council of Governments  

Glenn (SV) GLENN SACRAMENTO VALLEY GLENN COUNTY APCD 
  

Humboldt (NC) HUMBOLDT NORTH COAST NORTH COAST UNIFIED AQMD 
  

Imperial (SS) IMPERIAL SALTON SEA IMPERIAL COUNTY APCD SCAG Southern California Association of Governments 

Inyo (GBV) INYO GREAT BASIN VALLEYS GREAT BASIN UNIFIED APCD 
  

Kern (MD) KERN MOJAVE DESERT KERN COUNTY APCD KCOG Kern Council of Governments 

Kern (SJV) KERN SAN JOAQUIN VALLEY SAN JOAQUIN VALLEY UNIFIED APCD KCOG Kern Council of Governments 

Kings (SJV) KINGS SAN JOAQUIN VALLEY SAN JOAQUIN VALLEY UNIFIED APCD KCAG Kings County Association of Governments 

Lake (LC) LAKE LAKE COUNTY LAKE COUNTY AQMD 
  

Lassen (NEP) LASSEN NORTHEAST PLATEAU LASSEN COUNTY APCD 
  

Los Angeles (MD) LOS ANGELES MOJAVE DESERT ANTELOPE VALLEY AQMD SCAG Southern California Association of Governments 

Los Angeles (SC) LOS ANGELES SOUTH COAST SOUTH COAST AQMD SCAG Southern California Association of Governments 

Madera (SJV) MADERA SAN JOAQUIN VALLEY SAN JOAQUIN VALLEY UNIFIED APCD MCTC Madera County Transportation Commission 

Marin (SF) MARIN SAN FRANCISCO BAY AREA BAY AREA AQMD MTC Metropolitan Transportation Commission 

Mariposa (MC) MARIPOSA MOUNTAIN COUNTIES MARIPOSA COUNTY APCD 
  

Mendocino (NC) MENDOCINO NORTH COAST MENDOCINO COUNTY AQMD 
  

Merced (SJV) MERCED SAN JOAQUIN VALLEY SAN JOAQUIN VALLEY UNIFIED APCD MCAG Merced County  Association of Governments 
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Modoc (NEP) MODOC NORTHEAST PLATEAU MODOC COUNTY APCD 
  

Mono (GBV) MONO GREAT BASIN VALLEYS GREAT BASIN UNIFIED APCD 
  

Monterey (NCC) MONTEREY NORTH CENTRAL COAST MONTEREY BAY UNIFIED APCD AMBAG Association of Monterey Bay Governments 

Napa (SF) NAPA SAN FRANCISCO BAY AREA BAY AREA AQMD MTC Metropolitan Transportation Commission 

Nevada (MC) NEVADA MOUNTAIN COUNTIES NORTHERN SIERRA AQMD 
  

Orange (SC) ORANGE SOUTH COAST SOUTH COAST AQMD SCAG Southern California Association of Governments 

Placer (LT) PLACER LAKE TAHOE PLACER COUNTY APCD TMPO Tahoe Metropolitan Planning Organization 

Placer (MC) PLACER MOUNTAIN COUNTIES PLACER COUNTY APCD SACOG Sacramento Area Council of Governments 

Placer (SV) PLACER SACRAMENTO VALLEY PLACER COUNTY APCD SACOG Sacramento Area Council of Governments 

Plumas (MC) PLUMAS MOUNTAIN COUNTIES NORTHERN SIERRA AQMD 
  

Riverside (MD/MDAQMD) RIVERSIDE MOJAVE DESERT MOJAVE DESERT AQMD SCAG Southern California Association of Governments 

Riverside (MD/SCAQMD) RIVERSIDE MOJAVE DESERT SOUTH COAST AQMD SCAG Southern California Association of Governments 

Riverside (SC) RIVERSIDE SOUTH COAST SOUTH COAST AQMD SCAG Southern California Association of Governments 

Riverside (SS) RIVERSIDE SALTON SEA SOUTH COAST AQMD SCAG Southern California Association of Governments 

Sacramento (SV) SACRAMENTO SACRAMENTO VALLEY SACRAMENTO METROPOLITAN AQMD SACOG Sacramento Area Council of Governments 

San Benito (NCC) SAN BENITO NORTH CENTRAL COAST MONTEREY BAY UNIFIED APCD AMBAG Association of Monterey Bay Governments 

San Bernardino (MD) SAN BERNARDINO MOJAVE DESERT MOJAVE DESERT AQMD SCAG Southern California Association of Governments 

San Bernardino (SC) SAN BERNARDINO SOUTH COAST SOUTH COAST AQMD SCAG Southern California Association of Governments 

San Diego (SD) SAN DIEGO SAN DIEGO SAN DIEGO COUNTY APCD SANDAG San Diego Association of Governments 

San Francisco (SF) SAN FRANCISCO SAN FRANCISCO BAY AREA BAY AREA AQMD MTC Metropolitan Transportation Commission 

San Joaquin (SJV) SAN JOAQUIN SAN JOAQUIN VALLEY SAN JOAQUIN VALLEY UNIFIED APCD SJCOG San Joaquin Council of Governments 

San Luis Obispo (SCC) SAN LUIS OBISPO SOUTH CENTRAL COAST SAN LUIS OBISPO COUNTY APCD SLOCOG San Luis Obispo Council of Governments 

San Mateo (SF) SAN MATEO SAN FRANCISCO BAY AREA BAY AREA AQMD MTC Metropolitan Transportation Commission 

Santa Barbara (SCC) SANTA BARBARA SOUTH CENTRAL COAST SANTA BARBARA COUNTY APCD SBCAG Santa Barbara County Association of Governments 

Santa Clara (SF) SANTA CLARA SAN FRANCISCO BAY AREA BAY AREA AQMD MTC Metropolitan Transportation Commission 

Santa Cruz (NCC) SANTA CRUZ NORTH CENTRAL COAST MONTEREY BAY UNIFIED APCD AMBAG Association of Monterey Bay Governments 

Shasta (SV) SHASTA SACRAMENTO VALLEY SHASTA COUNTY AQMD SCRTPA Shasta Regional Transportation Agency 

Sierra (MC) SIERRA MOUNTAIN COUNTIES NORTHERN SIERRA AQMD 
  

Siskiyou (NEP) SISKIYOU NORTHEAST PLATEAU SISKIYOU COUNTY APCD 
  

Solano (SF) SOLANO SAN FRANCISCO BAY AREA BAY AREA AQMD MTC Metropolitan Transportation Commission 
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Solano (SV) SOLANO SACRAMENTO VALLEY YOLO/SOLANO AQMD MTC Metropolitan Transportation Commission 

Sonoma (NC) SONOMA NORTH COAST NORTHERN SONOMA COUNTY APCD MTC Metropolitan Transportation Commission 

Sonoma (SF) SONOMA SAN FRANCISCO BAY AREA BAY AREA AQMD MTC Metropolitan Transportation Commission 

Stanislaus (SJV) STANISLAUS SAN JOAQUIN VALLEY SAN JOAQUIN VALLEY UNIFIED APCD StanCOG Stanislaus Council of Governments 

Sutter (SV) SUTTER SACRAMENTO VALLEY FEATHER RIVER AQMD SACOG Sacramento Area Council of Governments 

Tehama (SV) TEHAMA SACRAMENTO VALLEY TEHAMA COUNTY APCD 
  

Trinity (NC) TRINITY NORTH COAST NORTH COAST UNIFIED AQMD 
  

Tulare (SJV) TULARE SAN JOAQUIN VALLEY SAN JOAQUIN VALLEY UNIFIED APCD TCAG Tulare County Association of Governments 

Tuolumne (MC) TUOLUMNE MOUNTAIN COUNTIES TUOLUMNE COUNTY APCD 
  

Ventura (SCC) VENTURA SOUTH CENTRAL COAST VENTURA COUNTY APCD SCAG Southern California Association of Governments 

Yolo (SV) YOLO SACRAMENTO VALLEY YOLO/SOLANO AQMD SACOG Sacramento Area Council of Governments 

Yuba (SV) YUBA SACRAMENTO VALLEY FEATHER RIVER AQMD SACOG Sacramento Area Council of Governments 
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APPENDIX 3: VEHICLE CATEGORIES 
EMFAC2011 Veh & 

Tech EMFAC2011 Vehicle Description EMFAC2007 
Vehicle 

EMFAC2007 
Vehicle 

Code 

Truck / Non-
Truck Category 

Truck 1 / 
Truck 2 / Non-

Truck 
Category 

LDA - DSL 
LDA Passenger Cars LDA PC 

Non-Trucks Non-Trucks 

LDA - GAS Non-Trucks Non-Trucks 

LDT1 - DSL 
LDT1 Light-Duty Trucks (0-3750 lbs) LDT1 T1 

Non-Trucks Non-Trucks 

LDT1 - GAS Non-Trucks Non-Trucks 

LDT2 - DSL 
LDT2 Light-Duty Trucks (3751-5750 lbs) LDT2 T2 

Non-Trucks Non-Trucks 

LDT2 - GAS Non-Trucks Non-Trucks 

LHD1 - DSL 
LHD1 Light-Heavy-Duty Trucks (8501-10000 lbs) LHDT1 T4 

Trucks Truck 1 

LHD1 - GAS Trucks Truck 1 

LHD2 - DSL 
LHD2 Light-Heavy-Duty Trucks (10001-14000 lbs) LHDT2 T5 

Trucks Truck 1 

LHD2 - GAS Trucks Truck 1 

MCY - GAS MCY Motorcycles MCY MC Non-Trucks Non-Trucks 

MDV - DSL 
MDV Medium-Duty Trucks (5751-8500 lbs) MDV T3 

Non-Trucks Non-Trucks 

MDV - GAS Non-Trucks Non-Trucks 

MH - DSL 
MH Motor Homes MH MH 

Non-Trucks Non-Trucks 

MH - GAS Non-Trucks Non-Trucks 

T6 Ag - DSL T6 Ag Medium-Heavy Duty Diesel Agriculture Truck 

MHDT T6 

Trucks Truck 2 

T6 CAIRP heavy - DSL T6 CAIRP heavy Medium-Heavy Duty Diesel CA International Registration 
Plan Truck with GVWR>26000 lbs Trucks Truck 2 

T6 CAIRP small - DSL T6 CAIRP small Medium-Heavy Duty Diesel CA International Registration 
Plan Truck with GVWR<=26000 lbs Trucks Truck 2 

T6 instate construction 
heavy - DSL 

T6 instate 
construction heavy 

Medium-Heavy Duty Diesel instate construction Truck with 
GVWR>26000 lbs Trucks Truck 2 

T6 instate construction 
small - DSL 

T6 instate 
construction small 

Medium-Heavy Duty Diesel instate construction Truck with 
GVWR<=26000 lbs Trucks Truck 2 

T6 instate heavy - DSL T6 instate heavy Medium-Heavy Duty Diesel instate Truck with GVWR>26000 
lbs Trucks Truck 2 

T6 instate small - DSL T6 instate small Medium-Heavy Duty Diesel instate Truck with 
GVWR<=26000 lbs Trucks Truck 2 

T6 OOS heavy - DSL T6 OOS heavy Medium-Heavy Duty Diesel Out-of-state Truck with 
GVWR>26000 lbs Trucks Truck 2 

T6 OOS small - DSL T6 OOS small Medium-Heavy Duty Diesel Out-of-state Truck with 
GVWR<=26000 lbs Trucks Truck 2 

T6 Public - DSL T6 Public Medium-Heavy Duty Diesel Public Fleet Truck Trucks Truck 2 

T6 utility - DSL T6 utility Medium-Heavy Duty Diesel Utility Fleet Truck Trucks Truck 2 
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T6TS - GAS T6TS Medium-Heavy Duty Gasoline Truck Trucks Truck 2 

T7 Ag - DSL T7 Ag Heavy-Heavy Duty Diesel Agriculture Truck 

HHDT T7 

Trucks Truck 2 

T7 CAIRP - DSL T7 CAIRP Heavy-Heavy Duty Diesel CA International Registration Plan 
Truck Trucks Truck 2 

T7 CAIRP construction - 
DSL 

T7 CAIRP 
construction 

Heavy-Heavy Duty Diesel CA International Registration Plan 
Construction Truck Trucks Truck 2 

T7 NNOOS - DSL T7 NNOOS Heavy-Heavy Duty Diesel Non-Neighboring Out-of-state 
Truck Trucks Truck 2 

T7 NOOS - DSL T7 NOOS Heavy-Heavy Duty Diesel Neighboring Out-of-state Truck Trucks Truck 2 

T7 other port - DSL T7 other port Heavy-Heavy Duty Diesel Drayage Truck at Other Facilities Trucks Truck 2 

T7 POAK - DSL T7 POAK Heavy-Heavy Duty Diesel Drayage Truck in Bay Area Trucks Truck 2 

T7 POLA - DSL T7 POLA Heavy-Heavy Duty Diesel Drayage Truck near South Coast Trucks Truck 2 

T7 Public - DSL T7 Public Heavy-Heavy Duty Diesel Public Fleet Truck Trucks Truck 2 

T7 Single - DSL T7 Single Heavy-Heavy Duty Diesel Single Unit Truck Trucks Truck 2 
T7 single construction - 

DSL 
T7 single 

construction Heavy-Heavy Duty Diesel Single Unit Construction Truck Trucks Truck 2 

T7 SWCV - DSL T7 SWCV Heavy-Heavy Duty Diesel Solid Waste Collection Truck Trucks Truck 2 

T7 tractor - DSL T7 tractor Heavy-Heavy Duty Diesel Tractor Truck Trucks Truck 2 
T7 tractor construction 

- DSL 
T7 tractor 

construction Heavy-Heavy Duty Diesel Tractor Construction Truck Trucks Truck 2 

T7 utility - DSL T7 utility Heavy-Heavy Duty Diesel Utility Fleet Truck Trucks Truck 2 

T7IS - GAS T7IS Heavy-Heavy Duty Gasoline Truck Trucks Truck 2 

PTO - DSL PTO Power Take Off Trucks Truck 2 

SBUS - DSL 
SBUS School Buses SBUS SB 

Non-Trucks Non-Trucks 

SBUS - GAS Non-Trucks Non-Trucks 

UBUS - DSL 
UBUS Urban Buses UBUS UB 

Non-Trucks Non-Trucks 

UBUS - GAS Non-Trucks Non-Trucks 

Motor Coach - DSL Motor Coach Motor Coach 

OBUS OB 

Non-Trucks Non-Trucks 

OBUS - GAS OBUS Other Buses Non-Trucks Non-Trucks 

All Other Buses - DSL All Other Buses All Other Buses Non-Trucks Non-Trucks 

 

• Source: http://www.arb.ca.gov/msei/vehicle-categories.xlsx  
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APPENDIX 4 SUMMARY OF RUN PARAMETERS FOR GENERATING CUSTOM 
ACTIVITY TEMPLATE 

Tab Run Parameters Description 

Area Area Type One of the area types can be picked. 

Area  One or more areas can be selected for one run.   

Time 
Calendar Year Between 2000 and 2050.  One or more calendar years can be selected for one run. 

Season/Month One of the three seasons (annual, summer, winter) or one of the 12 months can be selected for one run. 

VMT 

VMT Type Whether input VMT is by daily total or by vehicle and fuel type. 

Hourly Speed Fractions Whether to include custom hourly speed fractions. 

SB375  Whether it is a SB375 template. 

 

APPENDIX 5 SUMMARY OF RUN PARAMETERS FOR GENERATING CUSTOM 
ACTIVITY EMISSIONS INVENTORY 

Tab Run Parameters Description 

Load 
Template File Type Whether it is EMFAC2014 format or EMFAC2011 Format. 

SB375 Whether it is a SB375 run if EMFAC2011 Format is chosen. 

  Custom Activity File The custom activity file in EMFAC2014 or EMFAC2011 format. 

Output 

Report Type One or more of the reports (csv, planning inventory, or CTF) can be generated for a non-SB375 run. 

Report Type (SB375) Only SB375 report will be generated. 

Save data for future use Users can get results faster in the future if data from previous runs are saved and used. 

Output Directory Where to save output files. 

 

  

66 
 



 

APPENDIX 6 SUMMARY OF RUN PARAMETERS FOR GENERATING EMISSION 
RATES 

Tab Run Parameters Description 

Area Area Type One of the area types can be picked. 

Area  One or more areas can be selected for one run.   

Time 
Calendar Year Between 2000 and 2050.  One or more calendar years can be selected for one run. 

Season/Month One of the three seasons (annual, summer, winter) or one of the 12 months can be selected for one run. 

Vehicles 

Vehicle Class type Output by EMFAC2011 vehicle class or EMFAC2007 vehicle class or Truck/non-Truck or Truck1/Truck2/non-Truck.   

Vehicle Class One or more vehicle classes can be picked for one run. 

Model Year Aggregated or by model year in output.  One or more model years can be selected if by model year is picked. 

Fuel Aggregated or by fuel in output. 

Speed One or more speeds can be selected. 

Meteorology 
Temperature Temperature in Fahrenheit. 

Relative Humidity Relative humidity. 

Output 
Pollutants Pollutants in output. 

Output Directory Where to save output files. 
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APPENDIX 7 FIELDS IN CTF FILE 
FIELD NAME FIELD TYPE LENGTH FIELD DESCRIPTION 

YEAR NUMERIC 4 CAL YEAR OF THE RUN DATA 

DIS CHAR 3 DISTRICT ID 

AB CHAR 3 AIR BASIN ID 

CO NUMERIC 2 COUNTY ID 

EIC NUMERIC 14 EIC CODE 

PR NUMERIC (11,2) 11 ANNUAL PROCESS RATE 

HPDY NUMERIC 2 HOURS PER DAY 

DPWK NUMERIC 2 DAY PER WEEK 

JANT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR JANUARY - RANGE 0-100 

FEBT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR FEBRUARY - RANGE 0-100 

MART NUMERIC(4,1) 5 PERCENT ACTIVITY FOR MARCH - RANGE 0-100 

APRT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR APRIL - RANGE 0-100 

MAYT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR MAY - RANGE 0-100 

JUNT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR JUNE - RANGE 0-100 

JULT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR JULY - RANGE 0-100 

AUGT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR AUGUST - RANGE 0-100 

SEPT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR SEPTEMBER - RANGE 0-100 

OCTT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR OCTOBER - RANGE 0-100 

NOVT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR NOVEMBER - RANGE 0-100 

DECT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR DECEMBER - RANGE 0-100 

POL NUMERIC 9 POLLUTANT CODE 

EMFACT NUMBER (10,4) 11 EMISSION FACTOR (LBS PER EIC UNIT) 

SEASON CHAR 14 SEASON 

EMS NUMERIC(10,4) 11 EMISSIONS (TONS/DAY) 

VERSION CHAR 15 EMFAC VERSION 

OPERATOR CHAR 3 OPERATOR INITIALS 

TDATE DATE 8 TRANSACTION DATE 
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